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Windows : System Requirements
CPU : Pentium4 or higher, Recommended � Core2 duo

2.0 GHz or higher

Hard Disk : 250 megabytes of free hard disk space

CD Drive : A CD drive to load Vedic Vaastu in the
computer.

Monitor resolution : ColorMonitor with 16-bit color and 800x600

Operating System : WindowsXP, Vista,Windows 7

RAM : 1 GB, Recommended - 2 GB

Installation procedure

1 Insert the �Vedic Vaastu� CD in the CDDrive, and the program installation
will start automatically.

2. Follow the instructions of the installation program.

3. On the WELCOME screen, click on �Next� to proceed.

CHAPTER 1

INSTALLATION

Chapter 1 : Installation
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4. Please read the Licensee Agreement carefully. To install �Vedic Vaastu�, you
must accept the agreement and click �I Agree� to continue.
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5. The program is now in the process of installing and updating the Device
driver. Next, you will be prompted to attach the Hardware Key (provided
with the program) to your computer. Wait a few seconds to allow the com-
puter to recognize the key and then click on OK.

The �Next�, button will then be activated once the driver installation is
complete. Click on �Next� to continue.
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6. The next window allows you to choose whether you want to install all the
available languages or only a selected few. English language would be in-
stalled by default.
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8. The Installation has now been started.While the installation is in process, a
progress bar updates you about the progress of the installation and
displays the file names as they are being installed.

7. You can install the program in the folder already selected. Alternatively, you
can select a different path by clicking on �Browse�. We strongly recommend
that you install the program in the default folder.
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9. The next window shows that the installation has been successful. Click on
�Finish� to complete the set up process. It is recommended that you restart
your system.

Activating �Vedic Vaastu�

After launching �Vedic Vaastu� for the first time, you will need to activate it
with a password.

a. If your computer is connected to the Internet, the program will be auto-
matically activated.

b. If the computer is not connected to the Internet or the program cannot
detect the internet connection, then a screen will appear offering alternate
ways to activate your software.

If you select the first option �Download password� ( internet connectivity is
essential for this) then you need to enter your customer ID. Click onOK. �Vedic
Vaastu� will attempt to automatically activate itself by contacting ourwebserver.
If this fails for whatever reason, the earlier screen will reappear. Please use the
�Enter passwordManually� option.
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c. Alternatively, if internet based activation is not desired or not possible, you
can enter the password manually by selecting the �Enter password Manually�
option. You may call or e-mail Parashara Software to request your password.
You need to provide your name and System ID when you email. If you call,
please make sure you have this screen up and ready.
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Please do not fill in any information prior to contacting Parashara Soft-
ware. Please e-mail your System ID #, the name of the program (Vedic
Vaastu 1.0) and the full name under which the software was purchased to
sales@parasharasoftware.com. You can also obtain your password by
calling us at +91 141 2364129 or +91 141 2362084 between 10 am to 6 pm
Indian standard time. You will receive your name and password. Enter the
name and password exactly as given. The password is case-sensitive. If
your password is not accepted, it is most likely due to a typo in either name
or password.

Your software is now fully functional.

Enjoy!
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CHAPTER 2

USING BASIC FUNCTIONS OF VEDIC
VAASTU

Chapter 2 : Using basic functions of Vedic Vaastu

Configuring Vedic Vaastu
There are a few settings that dramatically influence the way the property lay-
out and auspiciousness grid is calculated and displayed. Because youmay have
a strong preference one way or the other, we will explain right away the most
important settings.

Selecting the Vaastu grid Area
Classical base of a Vaastu grid: The Vaastu Purush Mandal, a cosmic diagram
of the subjugated purusha with his head towards the northeast and his feet
towards the southwest, is actually ametaphysical representation for architec-
tural and planning purposes. The number of squares in the Mandal follow a
geometric progression of 1, 4, 9, 16, 25, 36, 49, 64, 81 and goes on till 1024
(which is the square of 32 and generally used for town-planning). The usual
numbers for residential structures are 64 or 81 (Ekasheeti Pada). This Mandal
provided a useful grid for the Sthapati to assign specific locations to different
rooms and also helped him in determining their relative proportions. In earlier
days, themeasurementsweremade in anthropomorphic units like angula (fin-
ger) or hasta (hand). Each of the godswas assigned a specific pada,with Brahma
occupying the center and 32 deities placed in the peripheral squares according
to their importance.

The positions of the different gods in the Mandal are the basis for related ac-
tivities in the house. For example, as Agni, the god of fire inhabits the southeast
corner, that is considered the ideal place to have a kitchen. Brahma, the su-
preme onewho inhabits the center, is also representative of the dimension above
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ground level. This portion is therefore left open to sky as a courtyard - a very
practical way of ensuring adequate light and ventilation in a house.

Vaastu specialists adopt different approaches when they draw the Vaastu grid
cells on the property shape. The Vaastu Grid Area can be set in three ways.
You can go to �Options Menu� > �Calculation Options� > �Vaastu Grid Area�.
This setting will be used as default setting for all the layouts that you work
upon.

In case youwish to customize a particular layout and choose some othermethod
to draw a grid, you can do so by clicking on the �Status Bar� > �Layout Op-
tions� > �Vaastu Grid Area� that you see at the bottom of the screen.

Customizing of the working layout is also possible at the initial data entry
level. On the Data Entry screen, where you select the Vaastu Category, there is
a button called �Options� on the left hand lower side. Clicking on this leads to a
screen where you can set the method for drawing the Vaastu grid. Please note
that this customized setting will be applicable to this particular layout only.

You can choose from any one of three methods to determine the placement of
the Vaastu grid. Please note that for perfect square and perfect rectangular
property shapes, the following three optionswill give the same result. This op-
tion is useful when the property shape is not a perfect square or a perfect rect-
angle.

Largest Circumscribed rectangle
This is the preferred option of vaastu specialists , who believe that if a property
is not a perfect rectangle, then a hypothetical rectangle inclusive of the prop-
erty area should be considered for placement
of vaastu grid. Although the name assigned
to this method contains the word rectangle,
this method can be used for all property
shapes including those that have extensions
or cuts of any ratio or proportion.

To understand this better, we should take a
bird�s eye view of the property.
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A largest possible rectangle is circumscribed
over the property shape. This rectangle cov-
ers the entire property area and in addition,
the area which would have been a part of
the property had the property been a per-
fect square or a perfect rectangle in shape.

TheVaastu grid is drawn on this circumscribed
rectangle.

The Vaastu padas, which lie beyond the pe-
riphery of the actual property shape, are con-
sidered to be missing. In this method we take
into consideration only those padas,which fall
within the boundary of the actual property
shape.

The advantage of this method is that padas are awarded a proportionate space
in the grid. The disadvantage of this method is that depending on the property
shape, many padas may get excluded.

Largest Inscribed rectangle
This is the preferred option of vaastu specialists who believe that if a property
is not a perfect rectangle, then a hypothetical rectangle drawnwithin the prop-
erty area should be considered for placement of vaastu grid. Although the name
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assigned to this method contains the word
rectangle, this method can be used for all
property shapes including those that have
extensions or cuts of any ratio or proportion.

To understand this better, we should take a
bird�s eye view of the property.

A largest possible rectangle is inscribedwithin
the property boundary.

The Vaastu grid is drawn on this rectangle.
The Vaastu padas, which lie on the outer pe-
riphery of the rectangle, can then be option-
ally stretched to include the area of extension
on their respective sides.

In this method we take into consideration all
the padas and simply increase the area covered
by the padas, which lie adjacent to the ex-
tended property area not covered by the larg-
est possible rectangle drawn by us at the first
level. So, here the outer periphery padas occupy
a greater area.
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The disadvantage of this method is that depending on the property shape, the
rectangular grid area may at times be very small and the peripheral padas may
be disproportionately bigger as compared to the other padas. The advantage is
that no pada gets excluded.

Actual Plot Shape
Thismethod can be adopted for properties that have four sides only. The area
under consideration is the actual property shape area. No extensions or cuts
are considered in this method. Unlike largest circumscribed rectangle, we do
not include any additional area while drawing the Vaastu grid. No pada is ex-
cluded or extended in this method. Consequently all the four directions and
the four cardinal directions find their proper place on the property super impo-
sition. In thismethod, any direction tilt variation is not reflected by a tilt of the
grid. If the direction tilt exceeds 45 degrees, in that case, the direction Tilt
indicator points to another side of the property.

There is one disadvantage in the Actual Plot Shape method. When the prop-
erty shape is not very close to a square or rectangle, some of the padas get
squeezed up due to space limitations, while others get stretched out.

Here are a few examples of Actual Plot Area for Rhombus, Goumukhi and
square shaped properties.
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Selecting the Direction/Grid consideration
Knowledge of direction is very relevant in order to
apply the tenets of Vaastu shastra on a plot of land. In
earlier days, the procedure was very elaborate. Today,
it has become very much easier to fix the directions
with the help of a magnetic compass.

A compass is an example of a free-floating magnet.
The face of the compass generally highlights the car-
dinal points of north, south, east and west. The earth�s force field can be ob-
served by the needle deflection of the compass. It is a navigational instrument
for determining direction relative to themagnetic poles of the earth. It consists
of a magnetized pointer (usually marked on the North end) free to align itself
with the magnetic field of the earth. The inclination of the earth field is 90° at
the North magnetic pole and -90° at the South magnetic pole. A typical com-
pass that is allowed to swing only in the horizontal planewill point in random
directions at either the South or Northmagnetic poles.

How to ascertain the direction tilt of your property
In order to ensure a flawless identification of directions, we should follow some
basic rules of application. Themagnetic needle of the compass is very sensitive
and while using it, we should ensure that it is placed away from other mag-
netic fields, electronic or iron objects, whichmay cause it tomalfunction.

1. Draw a line perpendicular to the front facing boundary of the property starting
from the center.

2. Draw two lines perpendicular to each other, and
formingperfect 90 degree angles on a flat plankofwood.
Treat the perpendicular line (Point 1.) as a reference
line and place the plank parallel to the reference line.
Now move the plank so that both the vertical lines
coincide.

3. Place the compass on the plank at the crossing point
of the two lines. Tap it gently to dislodge the needle in
case it is stuck.
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4. Themagnetic needle will waver and settle to point in one direction. This is the
North direction of the property.

5.When theNorth is not straight in the property, but has shifted by a small degree
to the reference line, then the axis is considered to be tilted. A tilt up to 7 degrees
is normally ignored.

Note:In Vedic Vaastu software, the side marked as 1 is treated as the Property facing side.
The North direction side is assumed to be the opposite side of the Property facing side. In
case you have the north angle available in reference to your front wall, kindly adjust it by
180 degrees to match the hypothesis obeserved by the software.

How to apply the property direction tilt consideration in the program layout
Once you have fixed the direction of the property, in reference to north, you
have to select between different approaches by clicking on the Options Menu
>Calculation Options which opens a window displaying the various options
for consideration of the direction tilt while drawing the Vaastu grid cells on the
property shape.

The selected options in theOptionsMenu>CalculationOptions>Direction/
Tilt consideration is the setting, that will be used as default setting for all the
files that you work upon. In case you wish to customize a particular file and
choose some other method to indicate the direction in the grid, you can do so
by clicking on the Status Bar> LayoutOptions>Direction Tilt Consideration
that you see at the bottom of the screen.

Customizing of the working file is also possible at the initial data entry level.
On the Data Entry screen, where you select the Vaastu Category, there is a
button called �Options� on the left hand lower side. Clicking on this leads to a
screen where you can set the method for indicating the direction while draw-
ing the Vaastu grid. Please note that this customized setting will be applicable
to this particular file only.

Let us now elaborate on the three types of tilt considerations. Vedic Vaastu
allows you to choose from any one of threemethods to determine the direction
tilt of the Vaastu grid. Please note that for properties having all the sides per-
fectly aligned to their respective directions, the following three optionswill give
the same result.
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Best Fit
The Best Fit method has been derived from the ancient classic Vaastu Vidya.
According to this, the best fit tilt directionmethod, which is generally used for
Ekasheetipada Trikona Vaastu or Ekasheetipada Vrita Vaastu can be applied
with equal ease to Ekasheetipada Rectangular Vaastu.

The deity pada allocation generally used in the ekasheetipada system (consid-
ering zero degree north) has been kept intact, and the available area for all the
directions has been allocated equally. Consequently all the four directions and
the four cardinal directions find their proper place on the property super impo-
sition. The grid is drawn concentricallywith 32 padas in the outermost periph-
ery, 24 in the second, 16 in the third, 8 in the fourth and 1 pada in the core. No
pada has been excluded. The padas in the concentric rectangles are also intact,
in as much as that the respective deities have been placed in their individual
positions.

Image of Best Fit Consideration (Square shape Prop-
erty and North direction tilted by 20 degrees)
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This is one of the most scientific approaches to draw a Vaastu grid (when the
north angle is deviated from its natural position), because of the following:

a. All the directions have been given equal weightage. This is in tandem
with the universe where all the directions occupy an equal span.
b. All the ekasheetipada deities have been assigned their due position based
on the direction.
c. All the eighty one padas have been retained (when there is no cut or
extension in the property) and consequently, there is no loss of padas.
d. This method has been inspired from the ancient Vedic Vaastu classics.

It may be noted that the results will vary if we consider a property with an
extension or cut, depending on whether we have chosen the circumscribed,
inscribed or actual plot area options for vaastu grid drawing. So, here we need
to relate this to the various options for the Vaastu Grid area individually.

Image of Best Fit Consideration (Property with Cut
in the NE and North direction tilted by 20 degrees)
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Largest Circumscribed Rectangle Best Fit Grid consideration
A largest possible rectangle is circumscribed over the property shape. This rect-
angle covers the entire property area and in addition, the area which would
have been a part of the property had the property been a perfect square or a
perfect rectangle in shape. The Vaastu grid is drawn concentrically on the cir-
cumscribed rectangle, with 32 padas in the outermost circle, 24 in the second,
16 in the third, 8 in the fourth and 1 pada in the core, keeping the north angle
deviation in consideration. The Vaastu padas, which lie beyond the periphery
of the actual property shape are considered to be missing. In this method we
take into consideration only those padas, which fall within the boundary of
the actual property shape.

Image of Circumscribed Best Fit Consideration
(Property with Cut in the NE and North direction

tilted by 20 degrees)
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Largest Inscribed Rectangle Best Fit Grid consideration
A largest possible rectangle is inscribedwithin the property boundary, without
considering the tilt of the north angle at this level. The Vaastu grid is drawn
concentrically on the inscribed rectangle, with 32 padas in the outermost circle,
24 in the second, 16 in the third, 8 in the fourth and 1 pada in the core, keeping
the north angle deviation in consideration. The Vaastu padas, which lie on the
outer periphery of the inscribed rectangle can optionally be stretched to in-
clude the area of extension on their respective sides.

Image of Inscribed Best Fit Consideration (Property
with Cut in the NE and North direction tilted by 20

degrees)
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Compress Fit
This is one of the simpler approaches to draw a Vaastu grid (when the north
angle is deviated from its natural position). Here, all the ekasheetipada deities
have been assigned their due position based on the direction. All the eighty one
padas have been retained (when there is no cut or extension in the property)
and consequently, there is no loss of padas.

A largest inscribed rectangle is drawn within the assigned property area, con-
sidering the north angle deviation. The Vaastu grid is drawn length wise and
breadthwise tomake up the 9x9= 81 cell grid. The Vaastu padas, which lie on
the outer periphery of the rectangle can optionally be stretched to include the
area on their respective sides. In this method, the span of the directions is un-
equal depending on the north angle deviation degree.

Image of Compress Fit Consideration (Property with
Cut in the NE and North direction tilted by 20

degrees)
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Here we need to relate this to the various options for the Vaastu Grid area.

Largest Circumscribed Rectangle Compress Fit Grid consideration
A largest possible rectangle is circumscribed over the property shape. This rect-
angle covers the entire property area and in addition, the area which would
have been a part of the property, if the property had been square or rectangle
in shape. This is the assigned area for the Ekasheetipada grid.

A largest inscribed rectangle is drawnwithin this assigned area, considering the
north angle deviation. The Vaastu grid is drawn length wise and breadth wise
to make up the 9x9 = 81 cell grid, within this inscribed rectangle. The Vaastu
padas, which lie on the outer periphery of the rectangle can optionally be
stretched to include the area on their respective sides. In this method, the span
of the directions is unequal depending on the north angle deviation degree. In
thismethodwe take into consideration only those padas,which fall within the
boundary of the actual property shape.

Image of Circumscribed Compress Fit Consideration
(Property with Cut in the NE and North direction

tilted by 20 degrees)
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Largest Inscribed Rectangle Compress Fit Grid consideration
A largest possible rectangle is inscribedwithin the property boundary, without
considering the tilt of the north angle at this level. This is the assigned area for
the Ekasheetipada grid.

A largest inscribed rectangle is drawnwithin this assigned area, considering the
north angle deviation at this level. The Vaastu grid is drawn length wise and
breadthwise tomake up the 9x9= 81 cell grid, within this inscribed rectangle.
The Vaastu padas, which lie on the outer periphery of the rectangle can option-
ally be stretched to include the area on their respective sides. In this method,
the span of the directions is unequal depending on the north angle deviation
degree.

Image of Inscribed Compress Fit Consideration
(Property with Cut in the NE and North direction

tilted by 20 degrees)
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Zero Tilt
The Zero Tilt methodworks on the assumption that the north direction is not
deviated from the central position of its respective side. So, the tilt consider-
ation is limited to a 90 degree span.

This implies that if the tilt angle is within the range of +45 degrees and �45
degrees of the 0 degreeNorth compass needle, it will be treated as though there
is no deviation in the north angle. If the tilt angle is within the range of 45 to
135 degree, then the north is uniformly considered to be deviated by 90 de-
grees. Similarly, if the tilt angle is within the range of 135 to 225 degree, then
the north is uniformly considered to be deviated by 180 degrees. Lastly, if the
tilt angle is within the range of 225 to 315 (-45) degree, then the north is uni-
formly considered to be deviated by 270 degrees.

The padas of the grid are drawn with 9 cells length wise and 9 cells breadth
wise to make up the 81 cell grid. Here we need to relate this to the various
options for the Vaastu Grid area.

Image of Zero Tilt Consideration (Square shape
Property with North direction tilted by 20 degrees)
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Largest Circumscribed Rectangle Zero Tilt Grid consideration
A largest possible rectangle is circumscribed over the property shape. This rect-
angle covers the entire property area and in addition, the area which would
have been a part of the property had the property been a perfect square or a
perfect rectangle in shape. The Vaastu grid is drawn on this circumscribed rect-
angle using the above zero tilt method. In this method we take into consider-
ation only those padas, which fall within the boundary of the actual property
shape.

Image of Circumscribed Zero Tilt Consideration
(Property with Cut in the NE and North direction

tilted by 20 degrees)
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Largest Inscribed Rectangle Zero Tilt Grid consideration
A largest possible rectangle is inscribed within the property shape. The Vaastu
grid is drawn on this inscribed rectangle using the above zero tilt method. The
Vaastu padas, which lie on the outer periphery of the rectangle can optionally
be stretched to include the area on their respective sides.

Image of Inscribed Zero Tilt Consideration (Property
with Cut in the NE and North direction tilted by 20

degrees)
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Setting the color preference for auspiciousness levels
You can select unique colors to denote Favorable,Moderate, Neutral andAvoid-
able auspicious direction levels for object and entity placements. This can be
done in the �OptionsMenu� > �Color Options�.

Opening an Existing Layout
Vedic Vaastu allows you to store and retrieve layouts on your hard drive. To
open a Layout that has been saved previously, there are three ways to do this:

Opening layouts with the Open dialog: If you wish to open a layout by using
its layout name (example: Moti Bhawan.vas) click on the �File Menu�, and se-
lect �Open�. The program will show you the Open dialog, where all available
layouts are listed. By default, the dialog box will take you to the default direc-
tory. Double click the layout name to open the same.
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File Manager#

Vedic Vaastu allows you to store and retrieve files on your hard drive. It also
supports arranging your charts in �groups� which makes it easy to organize
your files. To open a file that has been saved previously, click on the FileMenu,
and select FileManager. The programwill show you the Filemanager screen, in
which all available directories, groups and their individual layouts are listed by
name. By default, the dialog boxwill take you to the default directory. Double
click the file name to open the file.

All available directories are listed in the Directory section. You can remove a
directory or create a new sub directory by right clicking on the particular direc-
tory name.

Files can be assigned to groups listed in the Group section. To create a new
group, right click on �All Files� or any existing Group name in the �Group�
section. Next click on �Create new group� and assign it a name. Now when
you right click on any individual file in the middle column, you will get the
option - Assign to Group with the group name showing up in the sub menu.
Once you have assigned the file to a group, it will start showing up under the
relevant group additionally. Groups can be deleted or renamed by right click-
ing on the group name. To delete a file, right click on the file name and select
the delete option.

# Not Available in Personal Edition
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When a Property name is selected, it�s File name, Property name,Owner name,
Address, Category, Shape, Sub shape, Vaastu grid area, Direction tilt consider-
ation, Measurement unit and North angle tilt details will be displayed in the
right most panel of the File Manager window.

The Change Sort button allows you to change the sort criteria. The Change
Directory button allows you to browse through other directories in case you
have .vas files stored elsewhere and you need to access them.

Opening last used layouts: At the bottom of the File menu, the four last closed
layouts are listed. Simply select one of the names that appear there to open
that layout�s file.

Creating a New Layout
To create a new layout file, click on the File menu and select �New�. The Data
Entry screen appears. This screen contains all the different fields of informa-
tion to be specified to calculate a layout image. Let�s take a look at the different
fields and how to fill them out.

Select Vaastu Category
Please select any one Vaastu Category from the list provided on this screen.
There are four broad Vaastu Categories: Residential, Commercial, Industrial
and Religious. The comprehensive list is as follows:

Residential: Bungalow
Residential: Multi-Storey Plot
Residential: Flat
Commercial: Office
Commercial: Shop/Showroom
Commercial: Hotel/Resort/Club
Commercial: Hospital/Nursing Home$
Commercial: Educational Institute$
Industrial: Cottage Industry
Industrial: Small Scale Industry
Industrial: Large Scale Industry$

Religious: Temple$
Religious: Ashrama/Matha$

$ Not Available in Personal and Commercial Edition
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Property Name
Enter the Property name for easy recall. This field is mandatory. The name
specified here would be the name with which your layout is saved by default.
If you leave this field blank, by default your layoutwill be saved as �New Prop-
erty�.

Owner Name
Enter the name of the owner. This field is not mandatory.

Property Address
The property address can be entered here. This field is also not mandatory.
Click on Next to proceed to the next screen.
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Select Property Shape
This window contains all the Property Shapes supported in the program.
The Property shapes have been segregated into the following categories.

1. Rectangular Shape (Samaayata Chaturbhuja)
2. Square Shape (Vargaakar)
3. Left Parallelogram Shape (Vishamaayata Chaturbhuja)
4. Right Parallelogram Shape (Vishamaayata Chaturbhuja)
5. Left Rhombus Shape (Vishamaayata Chaturbhuja)
6. Right Rhombus Shape (Vishamaayata Chaturbhuja)
7. Cow�s Mouth Shape (Goumukhi Shape)
8. Lion�sMouth Shape (Simhamukhi Shape)

Once you make a selection from the Shape Category frame, a series of images
with all possible shape combinations pertaining to the category selected by you
will appear in the Shapes frame. Check the radio button next to the image,
which is closest to your property design.
Click on Next to proceed to the next screen.
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Define Property Dimensions
Here you need to define the dimensions for the property sides.

Define Sides
Consider the front side of your property as Side 1 and proceed in a clock wise
manner. For cases where the property sides are equal to opposite sides, the cor-
responding figureswill automatically appear once you enter the information in
the indicative field.

DefineDiagonals/Angles
If you select a property shapewhere the angles are not exactly 90 degrees, then
you will need to define either the angle or the diagonals so that the property
shape can be drawn accurately.

In the Property Dimensions section, there are two radio buttons. Select Diago-
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nal and enter the length of the diagonals, ensuring that the two diagonal lengths
are not interchanged bymistake. Look at the property image to ascertainwhich
is Diagonal1 and which is Diagonal2. Please note that if an incorrect value is
entered in this field, the programwill show an error message stating that it is
unable to draw the property image.

Alternatively, select the Angle radio button, and enter the dimension of the Left
Angle in degrees and minutes in the relevant field. Please note that if an incor-
rect value is entered in this field, the programwill show an error message stat-
ing that it is unable to draw the property image.

Road Indication
You will also need to specify the sides that have a road
lying adjacent to it. Click on Tab button on your keyboard
to indicate that you have finished entering the informa-
tion. A proportionate Property Outline will appear under
the property representation section.

Click on Next to proceed to the next screen.

Specify Direction

The colored image in the backdrop of the compass denotes the shape of the
property. The objective is to establish the exact tilt degree of your property in
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reference to the north direction. You can do this in either of the followingways.
Enter the exact value in degrees andminutes in the box provided and press the
Tab key to view the Compass needle direction. Or place the pointer on the edge
of the north needle edge and drag the needle to change the direction. The de-
grees and minutes field will get updated automatically.

Click on Finish. The Property Layout will be displayed on yourWorksheet.

Designing a Property layout

Placing Entities
When the Property Layout is displayed on the screen, you will see an Entity
Explorer on the left side of the screen. The Entities have been categorized under
different groups. You can choose to display any particular group of entities or
All Entities according to your preference. The entities will also be displayed as
per the Vaastu category.

Placing your cursor on the Entity image in the Entity Explorer will display the
name of the Entity in question. Click on the Entity that youwish to place. An
Auspiciousness Indicator Window will come up immediately indicating the
auspiciousness levels and act as a guide for correct Vaastu placement of the
Entity. Click on the Property Layout and the Entitywill be placed there. Please
note that the Entity will be placed on the Property Layout in the form of a
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blank rectangle with the Entity Name on it.

Any selected Entity can bemoved around, by dragging it. In case you know the
exact place inwhich youwish to place the Entity, you can right click anywhere
on the Entity and access the Move window where you can enter the exact X
and Y coordinates for placement.

Removing Entities
To delete a placed Entity, select the Entity and right click on it. A submenuwill
come up and you need to click on �Remove�

You can also delete it by selecting it and then clicking on the Delete key on
your keyboard.

Resizing Entities
To re-size an Entity, you have to select it first.When youmove the cursor over
the corners or side center pointsmarked by black dots, itwill change to a double
sided arrow that can be dragged to increase or decrease the size arbitrarily. The
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status bar at the bottom will automatically update the size, as you keep fine
tuning it.

In case you know the exact size in which youwish to have the Entity, you can
right click anywhere on the Entity and access the Re-size window where you
can enter the exact size.

Designing an Entity layout#

Placing Objects#

To place an object, the Entity Layout has to be open on the screen.

There are three ways of accessing the Entity Layout.

From the Plot mode
You can double click on the Entity in question and the Entitymode screenwill
open up.

From the main Menu
You can select an Entity by clicking on it. Now go to View Menu > Entity
mode to switch from the Plot mode to the selected Entity mode.

From the Tool Bar#

When the Entity Layout is displayed on the screen, you will see the Objects
Explorer on the side of the screen. The Objects have been categorized under
different groups. You can choose to display any particular group of objects or
All Objects according to your preference.

Placing your cursor on theObject image in theObject Explorer will display the
name of theObject in question. Click on theObject that youwish to place. An
Auspiciousness Indicator Window will come up immediately indicating the
auspiciousness levels and act as a guide for correct Vaastu placement of the
Object. Click on the Entity Layout and the Object will be placed there.

A selected Object can be moved around, by dragging it. In case you know the
exact place in which you wish to place the Object, you can right click any-

# Not Available in Personal Edition



40

where on theObject and access theMove dialogwhere you can enter the exact
X and Y coordinates.

Removing Objects#

To remove a placed Object, select the Object and right click on it. A submenu
will come up and you need to click on �Delete�.

You can also remove a placedObject, by selecting it and clicking on the Delete
key on your keyboard.

Resizing Objects#

ToRe-size anObject, you have to select it first.When youmove the cursor over
the corners or side center pointsmarked by black dots, itwill change to a double
sided arrow, that can be dragged to increase or decrease the size arbitrarily.
The status bar at the bottom will automatically update the size as you keep
fine tuning it.

Rotating Objects#

Select the Object you wish to rotate. When you move the cursor over the

# Not Available in Personal Edition
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corners marked by black dots, it will change to a circular arrow that
indicates that the object can be freely rotated.

In case you know the exact angle of rotation, you can right click
anywhere on the Object and access the �Rotate� windowwhere you can enter
the exact angle degree.

The programhas been designed so that objects do not extend beyond the bound-
ary line of the entity.When an object is placed close to the side or the corner, at
times there is insufficient space to allow the rotationwithout crossing the bound-
ary. In such cases, there is no response from the program when we use the
rotate cursor. For such cases, you should shift the object to the centre, rotate it
to the desired angle and then move it back to the desired position.

Placing an object over another object#

An object can be placed over another object. To bring the object from back to
front or vice versa, you can select the object that needs to be shifted. Right click
anywhere on the Object and access the Bring to Front or Send to Back func-
tionality.

Saving a Layout
If you followed the previous instructions about creating a new layout, you
should now have a layout on the screen, in the Entity or Object mode depend-
ing upon the level of operation. The title of the Window will show the name
[New Property.vas] in box brackets or the name that you entered as property
name during the data entry process.

To save the layout, click on the File menu and select Save. A dialog box will
come up and you can choose the folder and specify the layout name. The lay-
outwill be savedwith a .vas extension. This can also be done through the stan-
dard toolbar.

If the data was saved before, then simply select the Save command from the
File menu and the information will be saved.

# Not Available in Personal Edition



42

Editing a Layout
Now you know how to create a new layout file, and how to save it. Let�s see
how we change the data for a layout that was entered already. Click on the
Edit menu, and select Layout Data. The same form that is used for entering a
new data comes up, and you can alter the data as you wish. Click on Finish to
accept the changes, and the layout image will automatically be recalculated.
Kindly note that if you make any change to the shape, the dimensions will be
lost and you will have to re-specify them.

Printing a Layout
Vedic Vaastu allows two kinds of printouts: a complete Report available under
the Reports menu, as well as printouts of the various screens.

Printing from the Reports menu
The individual reports under the Reportsmenu can be printed by simply click-
ing on the Print button at the end of each report page. The Print to PDF button
allows you to print the Report as a PDF file.

For users of the Personal Edition, the individual reports can be accessed through
the Print Menu > Select Model feature.

Printing from the Print menu
The pre designed report models## under the Print menu can be printed by
selecting amodel and clicking on the �View and print� button at the bottom of
theModel Print window.

Printouts from the Screen
Virtually everything that can be shown on the screen can also be printed. Even
though the screens are designed to be used interactively, the program allows
you to print them. Click on the �File� menu, and select �Print screen� to print the
current screen. Because the proportion of the screen is different from the pro-
portion of a sheet of paper, the program has to improvise a little tomake it look
nice. Therefore, not every screen printout will fill the page, or make efficient
use of the much larger space available on paper.

##Partially Available inPersonalEdition
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CHAPTER 3

USINGOTHER FUNCTIONSOFVEDIC
VAASTU

Chapter 3 : Using other functions of Vedic Vaastu

Switching between Plot and Entity Layouts
The program allows you to switch from Plot mode to Entity mode in the fol-
lowingmanner.

Switching from Plot mode to Entity mode
You can double click on the Entity in question and the Entitymode screenwill
open up. You can select an Entity by clicking on it. Now go to View Menu >
Entity mode to switch from the Plot mode to the selected Entity mode.

Alternatively, click on the Plotmode to Entitymode icon available in the
Standard Tool Bar.

Switching from Entity to Plot mode
Go to View Menu > Plot mode to switch from the Entity mode to the
Plot mode. The F9 key can also be used as a shortcut.

Alternatively, click on the Plotmode to Entitymode icon available in the
Standard Tool Bar.

Saving multiple floor layouts for plot layout
Vedic Vaastu allows you to store and retrievemultiple floor layouts in the same
layout file. The Floor Manager screen in the File Menu facilitates this action.
The FloorManager displays a Floor List on the left side and the Floor Informa-
tion including the Floor Name andDescription on the right side. Select a floor
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from the Floor list and the relevant information will be displayed.

Please note that the Floor no. is automatically assigned by the program with
the lowest floor being 0 followed by 1,2 and so on. The basement is numbered
as -1, -2 and so on.

Right clicking on the selected Floor name opens a submenu that allows you to
do the following.

Move up:The selected floor/basement ismoved one level above its present posi-
tion in the Floor list.

Move down: The selected floor/basement is moved one level below its present
position in the Floor list.

Swap with:The selected floor/basement can exchange its position with any of
the other floors listed in the Floor list.

Delete: The selected floor/basement is deleted from
the Floor List. Please note that the Floor list cannot
be left blank. So, the Floor no. 0 cannot be deleted.
In case youwish to change the layout of Floor no. 0
or delete it all together, you can use theMove up or
Swap command to change its position and then use
the delete command. Also, the floor/basement that
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is currently open or active on yourworking area also cannot be deleted as long
as it is open. In order to delete it, you need to open some other floor on your
screen first.

Copy to: The selected floor/basement and its entity and object layout can be
copied to any other floor /basement of your choice from the existing floors/
basements available in the Floor List. Please note that you will lose the previ-
ously designed entity object layout of the floor /basement (that you are copy-
ing to) and it will become a replica of the floor/basement that you have been
copying from.

Clone:An exact copy or clone ismade of the selected floor/ basement and a new
floor/basement is created. You can then assign it a name and fill in its relevant
description.

Remove all Objects and Entities:The selected floor/basement is rendered blank
and all the objects and entities placed on it are removed.

To add a new floor or basement, click on Add Basement or Add Floor respec-
tively. Enter the Floor Name and Description. Clicking on Save will complete
the process. Nowwhen you select an entry from the Floor List, you can see all
the corresponding details on the right simultaneously.

You can switch between floors by clicking on the Floor tab in the Status Bar
that appears at the bottom of your screen.

Auspiciousness Indicator Window
When your screen is in the Plotmode, and you have selected an Entity from the
Entity Explorer, an Auspiciousness Indicatorwindow appears on the screen in a
miniaturemode. The Favorable,Moderate, Neutral and Avoidable areaswill be
color filled. Youwill know the exact auspicious area for the placement and can
move the Entity accordingly. This window will disappear when the Entity is
deselected. A small colored dot indicating the auspiciousness levelwill continue
to be displayed on the entity. The program allows you to choose the position
where you want to display the auspiciousness indicative colored dot on the
entity. It can be in the center, or any of the corners. You can display it in one or
more of the five position options that can be set in theOptionsMenu>Display
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Options> IndicateAuspiciousness in
corner.

The window will reappear if you re
select the Entity. You can set your
preference for the Auspiciousness In-
dicator in theOptionsmenu/Display
options by selecting any one of �Al-
ways show, Automatic Show and
Never show�.

Always Show:TheAuspiciousness In-
dicator will show on the screen the
first time you select any entity on
yourwork screen layout. Thereafter,
thewindowwill continue to remain
on your screen, evenwhen the object is de-selected. The auspiciousess areawill
be automatically refreshed whenever another entity or object is selected.

Automatic Show:TheAuspiciousness Indicatorwill showon the screen onlywhen
you select any entity on yourwork screen layout. Thereafter, thewindowwill
disappear when the object is de-selected. It will automatically reappear when
another entity or object is selected.

Never Show: The Auspiciousness Indicator will not show on the screen at all,
irrespective of whether any entity or object is selected on your work screen
layout.

Tool Bar
The standard toolbar helps identify and use the various options through easily
recognizable icons and their descriptions. It is displayed just below the Main
menu.

This entire toolbar could become a floatingwindow by double-clicking on the
control bar at the far left end of this toolbar. This toolbar can be restored to its
original position by clicking in the gray bar at the top and dragging it back to
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the top of the screen. Push the top of thewindowup to the bottomof themenu
bar. Hiding of standard toolbar is possible through the View menu. The Stan-
dard Tool Bar consists of the following:

File:Opens new layout data entry dialog

Open Layout :Opens or finds a Layout file

Save: Saves active layout file with current name, location and file for-
mat.

Print Layout: Prints the active Layout displayed on the screen

Cut: Cuts the selected layout, entity or object

Copy: Copies the selected layout, entity or object

Paste: Pastes the selected layout, entity or object

Full Screen: Switches from normal to full screen mode and vice versa

Plot mode: Switches from Entity mode to plot mode

Entity mode: Switches from Plot mode to entity mode

Zoom: Enlarges or reduce the display of the active layout

Direction Indicator: Shows/ hides Direction Indicator on layout
backdrop.

Font: Select or Change the font of the text.
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Font size: Adjust the font size of text

Bold:Display text in bold

Italics:Display text in italics

Underline:Underlines text

Status Bar

The Status Bar is located at the bottom of the Property Layout and Entity
Layout screen and displays the values pertaining to the current status of the
Entity or Object that has been selected in terms of the following. Some other
property related information like Direction tilt, Vaastu grid consideration etc.
is also available here. The facility to switch to some different option is also
available here.

Itmay be noted here that anyOptions related customization done through the
Status Bar is Layout specific and limited to the layout in question. It will not be
automatically followed for other individual layouts. This will also take prefer-
ence over changesmade done directly through theOptionsMenuTabwindow.
Let us look at each one of the components of the Status Bar.

Name: Name of Entity or Object. Example: Library, Table

Size: Size of Entity or Object (length, breadth). Example: 15.50,11.25 feet

Position: Position of Entity or Object. Example: 69.50,28.50 feet The x and y
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coordinates of an object (see Figure) determine its position as displayed on the
Status Bar at the bottom of the screen.

For rotated objects and objects that are not rectangular, the x and y coordi-
nates are determined by assuming a circumscribed bounding rectangle over the
object and assigning the same.

Direction: Direction of Property in reference to the North degree needle. Ex-
ample: 30 degree North TheNorth degree angle is always specified in reference
of side opposite front facing side.

Layout Options: The Measurement Unit, Vaastu Grid Area and Direction
Tilt consideration status is indicated here.

Floor: All the different floors in the layout are listed here and this feature
allows easy navigation between floors. If there is only one floor saved, then
there will be a single entry termed Ground Floor or a name of your choice.

Explorer Tool Box
The Tool Bar is positioned on the left side of the screen in the Plot and Entity
Layout mode. It consists of the Entity Explorer and the Object Explorer.

Entity Explorer
The Entity Explorer is visible in the Plot mode. The Entities have been catego-
rized into pertinent groups and the option to viewGroupwise or All Entities is
available. If the cursor is moved over the icon, the name of the entity can be
displayed. Single click on an Entity in the Explorer and then click anywhere
inside the Property Layout to place it there.

Clicking on the Cross sign next to Entity Explorer hides the Tool Bar from the
screen.
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Entity Explorer Object Explorer##

##PartiallyAvailable inPersonalEdition
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Object Explorer##
The Object Explorer is visible in the Entity mode. The Objects have been cat-
egorized into pertinent groups and the option to view Group wise or All Ob-
jects is available.

If the cursor is moved over the icon, the name of the object can be displayed.
Single click on an Object in the Explorer and then click anywhere inside the
Entity Layout to place it there.

Clicking on the Cross sign next to Object Explorer hides the Tool Bar from the
screen.

Context Menu: Right Click Options

Right Click on Entity
Right clicking on an Entity image in a plot layout
brings up a small popupmenu. Thismenuhas a num-
ber of commands, appropriate for the itemyou clicked
on. This includes the following:

Cut Command
The Cut Command allows you to cut the selected
entity.

Copy Command
TheCopyCommand allows you to copy the selected
entity.

Paste Command
The Paste Command allows you to paste the selected entity.

Remove Command
The Remove Command allows you to delete the selected entity.

Move Command
AMove command allows you tomove the entity by defining the exact X andY

##Partially Available inPersonalEdition
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coordinates. The keyboard arrow keys can also be used for moving entities.

Resize Command
The Resize command allows access to the Resize dialog, where you can enter
the exact size of the Entity.

Change Entity Name position
If the Entity name is being displayed on the Entity, then this feature allows you
to change its locationwithin the entity area. This requires that EntityName>
Show is selected from theOptionsmenu>DisplayOptions

Flip Horizontal Command
The FlipHorizontal Command allows you to flip the selected entity horizon-
tally.

Flip Vertical Command
The Flip Vertical Command allows you to flip the selected entity vertically.

Options Command
TheOptions command leads you directly to theOptionsmenu tab screenwith
easy access to the Calculation, Display, Explorer, Color, Print, Report and Font
options.

Right Click on Objects
Right clicking on an Object image in an Entity layout brings
up a small popup menu. This menu will have a number of
commands, appropriate for the item you clicked on. This will
include the following :

Cut Command
The Cut Command allows you to cut the selected object.

Copy Command
The Copy Command allows you to copy the selected object.

Paste Command
The Paste Command allows you to paste the selected object.
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Remove Command
The Remove Command deletes the selected object.

Move Command
AMove command allows you to move the object by defining the exact X and
Y coordinates. The keyboard arrow keys can also be used for moving entities.

Resize Command
The Resize command allows access to the Resize dialog where you can enter
the exact size of the object.

Rotate Command
The Rotate Command allows you to rotate a selected object to the exact angle
degree.

The rotation angle values are relative and not absolute. The angle value en-
tered by youwill be relative to the current position. For instance if the object is
placed at a 0 degree angle and you enter the angle degree as 15, then the object
will rotate 15 degrees clockwise. If you once again enter 15, then the resulting
position of the object will actually be 30 degrees clockwise rotated from origi-
nal position. Now if youwish to restore it to the original position, you need to
enter -30 or 330 to get the 0 degree postion. In short, negative values can also be
entered.

Notes: The programhas been designed so that objects do not extend beyond the boundry line of
the entity.When an object is placed close to the side or the corner, at times there is insufficient
space to allow the rotation without crossing the boundry. In such cases, there is no response
from the programwhenwe use the rotate command. For such cases, you should shift the object
to the centre, rotate it to the desired angle and thenmove it back to the desired position.

Flip Horizontal Command
The FlipHorizontal Command allows you to flip the selected object horizon-
tally.

Flip Vertical Command
The Flip Vertical Command allows you to flip the selected object vertically.
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Bring to Front and Send to Back Commands
This functionality is useful for objects placed on top of one another. To move
the object from back to front or vice versa, you can select the object that needs
to be shifted and use the appropriate command.

Options Command
The Options command leads you directly to the Options tab screen with easy
access to the Calculation, Display, Explorer, Color, Print, Report and Font op-
tions.

Right Click on Vaastu Assistant
The right click functionality allows you to do two things.
You can choose to hide the Vaastu Assistant from here.
If you like, you can change the Vaastu Assistant image
to one from a choice of three alternatives.

Shortcuts

Ctrl+N=New layout
Ctrl+O=Open layout
Ctrl+M= Floor Manager
Ctrl+S = Save layout
Ctrl+F4=Close layout
Ctrl+Q = Exit program
Ctrl+L= Last closed Layouts
Ctrl+C = Copy

Ctrl+C= Paste
Ctrl+Shift+C= Copy layout
F11=View layout in Full screenmode
F9=View layout in Plot mode
F1 =Manual
Arrow keys =Move selected object or
entity
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CHAPTER 4

PRINTINGTHROUGHVEDICVAASTU

Chapter 4 : Printing through Vedic Vaastu

Printing Layout Pages

Before proceeding for printing, please check the current printer settings by open-
ing the PrintOptions under theOptionsmenu. On this screen, select the paper
size and the margins.

In case you have not installed any printer under Windows, printing a page
from Vedic Vaastu may not be possible. To add a printer, click on the Start
button at the bottom left corner of the screen and then select Settings> Print-
ers. A new dialog will open with an icon Add Printer. Double click on this icon
and follow the instructions to add a new printer.

Any of the Plot or Entity# layouts can be printed on a printer. Click on Print
Screen under the File menu to send the current screen to the printer.

Printing Reports Menu Printouts

The Reports under the Reports menu can be printed by simply clicking on the
Print button at the end of the Report. The Print to PDF button allows you to

# Not Available in Personal Edition
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print the Report as a PDF file. For users of the Personal Edition, a limited num-
ber of individual reports can be accessed through the PrintMenu>SelectModel
feature.

Printing a Set of Pages (Model Printing)

Vedic Vaastu allows the user to select from a pre-organized set of printouts##,
called �Models�, or to make customised set of printouts.

##Partially Available inPersonalEdition
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Editing orMaking a NewModel#
The SelectModel screen under the Print menu can also be used to edit or add a
new printout to the existing set of printouts. Open the SelectModel screen by
clicking SelectModel in the Printmenu.

To edit an existing model, select the model you wish to edit and press Edit
button. If you wish to change the name of the model and price, you can do so
in the box Change name or price.

To add a newmodel, select the entry Newmodel and press Edit button. A new
screen will come up. Assign a name to the model in the box Change name and
in case you want to sell the report, give a selling price of the model in the Price
box.

The screen displays all the available printouts on the right side and the print-
outs selected for the model on the left side. If you notice, each printout has
been given a unique number.
To add a printout to the model, click on the printout number listed under the
Available printouts and click on the right facing arrow.

# Not Available in Personal Edition
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To remove a printout, click on the printout number in the selected printouts list
and click on the left facing arrow. You can also select multiple printouts and
remove them simultaneously.

To insert a printout in between already selected printouts, select the printout
under selected printouts after which you wish to add a new printout. Now
select the printout number in the list of available printouts and click on the
right facing arrow to insert the printout in the model

Click Save to save themodel. ClickCancel to close the dialogwithout saving the
changes that you have made.

List of Models

Model: VFE1
Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
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Model: VFO1#

Contents:
Opening Page
Introduction
Property Details
Floor(s) Map with Objects

Model: VFE2
Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
Summary Introduction
Macrocosm Score
Vaastu Tips

Model: VFO2#

Contents:
Opening Page
Introduction
Property Details
Floor(s) Map with Objects
Summary Introduction
Macrocosm Score
Microcosm Score
Vaastu Tips

Model: VFE3
Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
Entities Description
Summary Introduction

# Not Available in Personal Edition



60

Macrocosm Score
Vaastu Tips

Model: VFE4
Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
Entities Description
EntityMapwith Objects Description
Summary Introduction
Macrocosm Score
Vaastu Tips

Model: VFE5#

Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
Entities Description
Entity Map(s)
Summary Introduction
Macrocosm Score
Microcosm Score
Vaastu Tips

Model: VFE6#

Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
Entities Description
EntityMapwith Objects Description
Summary Introduction

# Not Available in Personal Edition
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Macrocosm Score
Microcosm Score
Vaastu Tips

Model: VFO3#

Contents:
Opening Page
Introduction
Property Details
Floor(s) Map with Objects
Entities Description
EntityMapwith Objects Description
Summary Introduction
Macrocosm Score
Microcosm Score
Vaastu Tips

Model: VDR1#

Contents:
Opening Page
Introduction
Property Details
Floor(s) Mapwithout Objects
Floor(s) Map with Objects
Entities Description
EntityMapwith Objects Description
Summary Introduction
Macrocosm Score
Microcosm Score
Vaastu Tips

# Not Available in Personal Edition



62

CHAPTER 5

MENUREFERENCES

Chapter 5 : Menu References

The menu reference gives a systematic description of all commands available
from the menus. It is meant to be used as complimentary information to the
earlier chapters. The menu bar contains the followingmenus.
File
Edit
View
Reports#

Tutorial*

Options
Print
Tools#

Window
Help

By selecting any of these any of these you will get a list of submenus for that
particular menu. Later on we will explain in detail the purpose of each of the
submenus. Here is a quick introduction to each of the main menu items.

File
Thismenu contains all the functions that are related to saving layout informa-
tion to the disk, retrieving it and entering new data. The file menu allows you
to open more than one layouts at a time, and each layout�s data will be dis-
played in a separate window.

Edit
This menu contains all the functions used for changing layout information.
This can be Layout data, Copying a layout and Astrologer specific settings.
The Delete submenu option can be used to remove objects or entities from

# Not Available in Personal Edition *NotAvailable inCommercial Edition
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the layout.

View
From this menu you can select view layout modes and other features that you
want displayed.

Reports#
This menu contains detailed Reports that you can view and print. These
reports can also be printed as a PDF file. For users of the Personal Edition, the
individual reports can be accessed through the PrintMenu> SelectModel fea-
ture.

Tutorial*

This section contains some personalized Vedic Vaastu lessons in the form of an
extensive tutorial. The lessons have been organized systematically and are pre-
sented in a lucid language. This is almost a complete tutorial with a rich intro-
duction and a lot ofmaterial for Vaastu related principles. Details and interest-
ing facts about the Ekasheetipada deities can also be viewed here.

Options
This menu contains all the options that you can change to customize the
behavior of the program.

Print
It contains all the standard Report printouts## and the tool to design your own
reportmodels.

Tools###

It contains some useful tools to help you search for or export layouts; access
statistics on groups of layouts; calculate the Aayadi score for the layout and
send Emails directly through this menu.The Accounting Tool is a very handy
tool for viewing and printing a record of reports printed through the program
over a specific period.

Windows
This menu allows you to tile or cascade all the layouts open at a time. You can

* Not Available in Commercial Edition
###NotAvailableinPersonalEdition & onlyPartiallyinCommercialEdition
##Partially Available inPersonalEdition
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also switch to any of the open layouts through this menu.

Help
You can access an OnlineManual through this menu.

The File Menu
When you select File you will get a pull down menu with the following sub
menu items. At the end of the sub menu items, you can see the names of the
four most recently used layouts for easy access.

When you run this program for the first time, there will only be some sample
layouts for you. To create your own layouts, you have to click on New under
the File menu to create a new layout.

New
This option leads you to a Data Entry Window where you have to enter the
following details.
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Select Vaastu Category
Check any one Vaastu Category from the list provided on this screen.
Property Name: Enter the Property name for easy recall. This field is man-
datory. The name specified here will be the name by which your layout is
saved. If you leave this field blank, by default your layout will be saved by
the name �New Property�.

Owner Name: Enter the name of the owner. This field is not mandatory.

Property Address: The property address can be entered here. This field is
also not mandatory.

Options: The Options button on the lower left side allows you to set the
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Vaastu Grid Area, Direction Tilt consideration and Measurement unit op-
tions.

Notes: The Notes button allows access to a screen/dialog, where you can
store any kind of text along with the layout. That could be the owner �s
address, comments on the layout, or anything else that is useful to you.
The Print button allows you to print the same.

Click on Next to proceed to the next screen.

Select Property Shape
This window contains all the Property Shapes supported in the program.
The Property shapes have been segregated into the following categories.

1. Rectangular Shape (Samaayata Chaturbhuja)
2. Square Shape (Vargaakar)
3. Left Parallelogram Shape (Vishamaayata Chaturbhuja)
4. Right Parallelogram Shape (Vishamaayata Chaturbhuja)
5. Left Rhombus Shape (Vishamaayata Chaturbhuja)
6. Right Rhombus Shape (Vishamaayata Chaturbhuja)
7. Cow�s Mouth Shape (Goumukhi Shape)
8. Lion�sMouth Shape (Simhamukhi Shape)
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Once you make a selection from the Shape Category frame, a series of images
with all possible shape combinations pertaining to the category selected by you
will appear in the Shapes frame. Check the radio button next to the image,
which is closest to your property design.
Click on Next to proceed to the next screen.

Define Property Dimensions
Here you need to define the dimensions for the property sides.

Define Sides
Consider the front side of your property as Side 1 and proceed in a clock wise
manner. For cases where the property sides are equal to opposite sides, the cor-
responding figureswill automatically appear once you enter the information in
the indicative field.

DefineDiagonals/Angles
If you select a property shapewhere the angles are not exactly 90 degrees, then
you will need to define either the angle or the diagonals so that the property
shape can be drawn accurately.

In the PropertyDimensions section, there are two radio buttons. Select �Diago-
nal� and enter the length of the diagonals, ensuring that the twodiagonal lengths
are not interchanged bymistake. Look at the property image to ascertainwhich
is Diagonal1 and which is Diagonal2. Please note that if an incorrect value is
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entered in this field, the programwill show an error message stating that it is
unable to draw the property image.

Alternatively, select the �Angle� radio button, and enter the dimension of the
Left Angle in degrees and minutes in the relevant field. Please note that if an
incorrect value is entered in this field, the programwill show an error message
stating that it is unable to draw the property image.

Road Indication
You will also need to specify the sides that have a road ly-
ing adjacent to it. Click on Tab button on your keyboard
to indicate that you have finished entering the informa-
tion. A proportionate Property Outline will appear under
the property representation section.
Click on Next to proceed to the next screen.
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Specify Direction

The colored image in the backdrop of the compass denotes the shape of the
property. The objective is to establish the exact tilt degree of your property in
reference to the north direction. You can do this in either of the followingways.
Enter the exact value in degrees andminutes in the box provided and press the
Tab key to view the Compass needle direction. Or place the pointer on the edge
of the north needle edge and drag the needle to change the direction. The de-
grees and minutes field will get updated automatically.

Click on Finish. The Property Layout will be displayed on yourWorksheet.

Open
This option is used to open a previously saved layout. It lets you load in layouts
that you have saved in the hard drive. If youwish to open a layout by using its
layout name (example: Motibhawan.vas) click on the File Menu, and select
Open. The program will show you the File Open dialog where all available
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layouts are listed. By default, the dialog box will take you to the default direc-
tory. Double click the layout name to open the same.

FileManager#

Vedic Vaastu allows you to store and retrieve files on your hard drive. It also
supports arranging your charts in �groups� which makes it easy to organize
your files. To open a file that has been saved previously, click on the FileMenu,
and select FileManager. The programwill show you the Filemanager screen, in
which all available directories, groups and their individual layouts are listed by
name. By default, the dialog boxwill take you to the default directory. Double
click the file name to open the file.

All available directories are listed in the Directory section. You can remove a
directory or create a new sub directory by right clicking on the particular direc-
tory name.

Files can be assigned to groups listed in the Group section. To create a new
group, right click on �All Files� or any existing Group name in the �Group�
section. Next click on �Create new group� and assign it a name. Now when
you right click on any individual file in the middle column, you will get the
option - Assign to Group with the group name showing up in the sub menu.
Once you have assigned the file to a group, it will start showing up under the
relevant group additionally. Groups can be deleted or renamed by right click-
ing on the group name. To delete a file, right click on the file name and select
the delete option.

When a Property name is selected, its File name, Property name, Owner name,

# Not Available in Personal Edition
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Address, Category, Shape, Sub shape, Vaastu grid area, Direction tilt consider-
ation, Measurement unit and North angle tilt details will be displayed in the
right most panel of the File Manager window.

The Change Sort button allows you to change the sort criteria. The Change
Directory button allows you to browse through other directories in case you
have .vas files stored elsewhere and you need to access them.

Opening last used layouts: At the bottom of the File menu, the four last closed
layouts are listed. Simply select one of the names that appear there to open
that layout�s file.

FloorManager

Vedic Vaastu allows you to store and retrievemultiple floor layouts in the same
layout file. The Floor Manager screen in the File Menu facilitates this action.
The FloorManager displays a Floor List on the left side and the Floor Informa-
tion including the Floor Name andDescription on the right side. Select a floor
from the Floor list and the relevant information will be displayed.
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Please note that the Floor no. is automatically as-
signed by the programwith the lowest floor being 0
followed by 1,2 and so on. The basement is num-
bered as -1, -2 and so on.

Right clicking on the selected Floor name opens a
submenu that allows you to do the following.

Move up: The selected floor/basement is moved one
level above its present position in the Floor list.

Move down: The selected floor/basement is moved one level below its present
position in the Floor list.

Swap with:
The selected floor/basement can exchange its position with any of the other
floors listed in the Floor list.

Delete: The selected floor/basement is deleted from the Floor List. Please note
that the Floor list cannot be left blank. So, the Floor no. 0 cannot be deleted. In
case you wish to change the layout of Floor no. 0 or delete it all together, you
can use theMove up or Swap command to change its position and then use the
delete command. Also, the floor/basement that is currently open or active on
yourworking area also cannot be deleted as long as it is open. In order to delete
it, you need to open some other floor on your screen first.

# Not Available in Personal Edition
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Copy to: The selected floor/basement and its entity and object layout can be
copied to any other floor /basement of your choice from the existing floors/
basements available in the Floor List. Please note that you will lose the previ-
ously designed entity object layout of the floor /basement (that you are copy-
ing to) and it will become a replica of the floor/basement that you have been
copying from.

Clone:An exact copy or clone ismade of the selected floor/ basement and a new
floor/basement is created. You can then assign it a name and fill in its relevant
description.

Remove all Objects and Entities:The selected floor/basement is rendered blank
and all the objects and entities placed on it are removed.

To add a new floor or basement, click on Add Basement or Add Floor respec-
tively. Enter the Floor Name and Description. Clicking on Save will complete
the process. Nowwhen you select an entry from the Floor List, you can see all
the corresponding details on the right simultaneously.

You can switch between floors by clicking on the Floor tab in the Status Bar
that appears at the bottom of your screen.

Save
This option is used to save layout information. All layouts are savedwith a .vas
extension. If you entered new data or if you changed the existing data, you
may want to store any changes made through this Save feature.

Save As
With this option you can save the layout information you are working on un-
der a different layout name. This is useful when you wish to make multiple
designs for the same property.

Close
This command closes the current layout.

Print Screen
Any of the property or entity# layouts displayed on the screen can be printed
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with the help of this function. Please refer to Chapter 4: Printing through
Vedic Vaastu for more details on printing from the program.

Language
Select the language of the software through this function.

Exit
Before the program quits, it will check if there are any unsaved layouts. You
will be prompted for each unsaved layout.

The Edit Menu
This menu contains all the functions that relate to editing Layout Data, copy-
ing it to a Word file or storing and retrieving the contact details of multiple
Vaastu specialists for Report printing purposes.

Layout Data
If you wish to edit any changes in the Layout data pertaining to Vaastu cat-
egory, property shape, property dimension or property direction, you can do so
fromhere. TheData EntryWindowwill come upwith all the values previously
entered by you. These can be edited as per your requirement. This is exactly
like entering the data for a new layout, except for the fact that the fields are
not blank. For more details you can read Chapter2: Using Basic Functions of
Vedic Vaastu > Creating a new layout

# Not Available in Personal Edition
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Notes
The Notes form allows you to store any kind of text along with the layout.
That could be the owner �s address, comments on the layout, or anything
else that is useful to you. The Notes can be displayed on the worksheet. The
Print button allows you to print the same.

Select All
This feature allows you to select all the entities if the worksheet area is in the
Plot mode and all objects if the worksheet area is in the entity mode.

Cut
The Cut feature allows you to cut the selected layout, entity or object.

Copy
The Copy feature allows you to copy the selected layout, entity or object.

Paste
The Paste feature allows you to paste the selected layout, entity or object.

Copy Layout
This feature allows you to copy the layout and paste it in any application in
the form of an image.

Vaastu Specialist
You can set the details of a large number of Vaastu specialists in the program.
Click on the Vaastu Specialist button. Under the heading Vaastu Specialist, you
can save any number of different names and details. Clicking on Add New
gives you access to a blank window, where all the relevant details like name,
address, phone, fax, email and website can be entered and saved. This name
and address is printed in case you choose to print the opening page in a Vedic
Vaastu report. You can also set the most frequently used Vaastu specialist as
default by clicking on the check box.
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The View Menu
This menu allows you to decide all the
features that you want displayed by
checking or un-checking the relevant en-
try.

Full Screen
The screen layout can be viewed in a full
screen mode with no other menu or tool
bar visible. This is a read only mode and
no editing or addition is possible in this
mode. Please note that only the the Plot
mode can be viewed in this mode.

Plot Mode
The Layout can be seen in the PlotMode
by checking this feature. The program
has to be in thismode if youwish to place
new ormake changes in existing entities.
The Entity Explorer is visible on the left
side of the screen in this mode.

Entity Mode
The Layout can be seen in the Entity Mode by checking this feature. The pro-
gram has to be in this mode if youwish to place new ormake changes in exist-
ing objects. The Object Explorer is visible on the left side of the screen in this
mode.

Entity Explorer
The Entity Explorer is visible in the Plot mode, when this feature is checked.
The Entities have been categorized into pertinent groups and the option to
viewGroupwise or All Entities is available.

If the cursor is moved over the icon, the name of the entity can be displayed.
Single click on an Entity in the Explorer and then click anywhere inside the
Property Layout to place it there. Clicking on the Cross sign next to Entity
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Entity Explorer Object Explorer##

##Partially Available inPersonalEdition
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Explorer hides the Tool Bar from the screen. Entity Explorer preferences can be
set from theOptionsMenu/Explorer Options.

Object Explorer##
TheObject Explorer is visible in the Entitymode, when this feature is checked.
The Objects have been categorized into pertinent groups and the option to
view Group wise or All Objects is available.

If the cursor is moved over the icon, the name of the object can be displayed.
Single click on an Object in the Explorer and then click anywhere inside the
Entity Layout to place it there. Clicking on the Cross sign next to Object Ex-
plorer hides the Tool Bar from the screen. Object Explorer# preferences can be
set from theOptionsMenu/Explorer Options.

Tool Bar
The standard toolbar helps identify and use the various options through easily
recognizable icons and their descriptions. It is displayed just below the Main
menu.

This entire toolbar could become a floatingwindow by double-clicking on the
control bar at the far left end of this toolbar. This toolbar can be restored to its
original position by clicking in the gray bar at the top and dragging it back to
the top of the screen. Push the top of thewindowup to the bottomof themenu
bar. Hiding of standard toolbar is possible through the View menu. The Stan-
dard Tool Bar consists of the following:

File:Opens new layout data entry dialog

Open Layout :Opens or finds a Layout file

Save: Saves active layout file with current name, location and file for-
mat.

Print Layout: Prints the active Layout displayed on the screen

##Partially Available inPersonalEdition
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Cut: Cuts the selected layout, entity or object

Copy: Copies the selected layout, entity or object

Paste: Pastes the copied layout, entity or object

Full Screen: Switches from normal to full screenmode and vice versa

Plot mode: Switches from Entity mode to plot mode

Entity mode: Switches from Plot mode to entity mode

Zoom: Enlarges or reduce the display of the active layout

Direction Indicator: Shows/ hides Direction Indicator on layout
backdrop.

Font: Select or Change the font of the text

Font size: Adjust the font size of text

Bold:Display text in bold

Italics:Display text in italics

Underline:Underlines text

Status Bar

The Status Bar is located at the bottom of the Property Layout and Entity
Layout screen and displays the values pertaining to the current status of the
Entity or Object that has been selected in terms of the following. Some other
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property related information like Direction tilt, Vaastu grid consideration etc.
is also available here. The facility to switch to some different option is also
available here.

Itmay be noted here that anyOptions related customization done through the
Status Bar is Layout specific and limited to the layout in question. It will not be
automatically followed for other individual layouts. This will also take prefer-
ence over changesmade done directly through theOptionsMenuTabwindow.
Let us look at each one of the components of the Status Bar.

Name: Name of Entity or Object. Example: Library, Table

Size: Size of Entity or Object (length, breadth). Example: 15.50,11.25 feet

Position: Position of Entity or Object. Example: 69.50,28.50 feet The x and y
coordinates of an object (see Figure) determine its position as displayed on the
Status Bar at the bottom of the screen.

For rotated objects and objects that are not rectangular, the x and y coordi-
nates are determined by assuming a circumscribed bounding rectangle over the
object and assigning the same.

Direction: Direction of Property in reference to the North degree needle. Ex-
ample: 30 degree North TheNorth degree angle is always specified in reference
of side opposite front facing side.

Layout Options: The Measurement Unit, Vaastu Grid Area and Direction
Tilt consideration status is indicated here.

Floor: All the different floors in the layout are listed here and this feature
allows easy navigation between floors. If there is only one floor saved, then
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there will be a single entry termed Ground Floor or a name of your choice.

Auspiciousness Indicator
Thismenu allows you to decidewhether and how the auspiciousness indicator
Window should show on the screen, when the entity or object is selected.

Assistant
Instant Vaastu guidance is available through this feature. You can choose to
have it show up automatically for a short while, or for it to always be dis-
played, or for it to stay hidden.

Entity Name
The Entity Name for all placed entities starts showing up on the layout when
the screen is in the Plot mode.

Entity Size
The Entity Size for all placed entities starts showing up on the layoutwhen the
screen is in the Plotmode.

Ekasheeti pada grid#

The Ekasheeti pada grid display options can be set up to hide or show the grid
with orwithout numbers on the layoutwhen the screen is in the Plot or Entity
mode.

Direction Indicator#
The Direction Indicator indicates the direction and direction tilt degree of the
layout.

The Reports Menu#

This menu contains the Reports that you can see on screen for a particular
property layout. You can also print the individual report pages from here. The
report comprises of a Opening page, Introduction, property details, floor map
(with# or without objects ), entity description, entity map, map and object#
description# , summary, score pages and some handy Vaastu tips. To view the
report, click on Print Preview. Click on Print to take a printout of the same.
Click on Save as PDF to save a PDF copy of the report.

# Not Available in Personal Edition
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For users of the Personal Edition, the individual reports can be accessed through
the Print Menu > Select Model feature.

The Tutorial Menu*

This section contains some Vedic Vaastu lessons in the form of an extensive
tutorial. The lessons have been organized systematically and are presented in a
lucid language. This is almost a complete tutorial with a rich introduction and
a lot of Sanskrit shlokas and quotations that make interesting reading.
The Vaastu Tutorial comprises of the following chapters. It starts with an ex-
tensive Table of Contents.

*NotAvailable inCommercial Edition
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Chapter I: Introduction and Significance of Vaastu Shastra *

This chapter introduces the user to the basics of Vaastu science in reference to
the four Vedas, Ramayana, Mahabharata, Ashtadhyayi, Artha shastra, Jain
and Buddha classics, Aagama, Tantras, Puranas and Brihat Samhita that are
the exponential classics for Vaastu shastra.

The founder fathers of Vaastu Shastra, the legend and history of the Vaastu
purush and the Ekasheetipada Vaastu Mandal have also been discussed here.
Details and interesting facts about the Ekasheetipada deities, Rekha devis and
Directional Divine Entities lends a classical base to the learning process. The
Ekasheetipada deities have been graphically displayed alongwith a brief write-
up about each one of them.

Chapter II: Vaastu Shastra: Objectives and Basic Principles *

As the name implies, this chapter throws light on the objectives and basic prin-
ciples of Vaastu shastra. Gravitational Force, Magnetic Force and Solar Energy
are the three natural forces which exercise and endless power amidst the inter-
play of creation, evolution and destruction. The PanchaMahabhootas - Space
(Aakash), Air (Vaayu), Fire (Agni), Water (Jala) and Earth (Prithvi) have also
been elaborately discussed here.

The principles of Macrocosm and Microcosm as applicable to Vaastu shastra
have also received due significance. The use of themagnetic compass for flaw-
less identification of directions has been explained also.

Last but not the least, a section on Aayadi Garbha ganana or Aayadi calcula-
tion has also been included.

Chapter III: Types of Vaastu *

Residential, Commercial, Industrial and Religious types of Vaastu have been
discussed in detail in this chapter.

Residential Vaastu includes Vaastu for Leaf thatched Huts, Wooden Houses,
Temporary Houses and Concrete Houses. Commercial or Business Vaastu in-
cludes Vaastu for Shop, Showroom, Office, Hotel, Resort, Club, Hospitals,

*NotAvailable inCommercial Edition
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Nursing Homes and Educational Institutions. Industrial Vaastu includes Cot-
tage and small scale industries, Mills, Workshops and Industries.
Religious Vaastu includes Temple, Gurudwara, Ashram,Math, Sthanak, Bodh
Vihar, Dharamshala, Guest house, Community center,Wells, tanks, ponds and
Lakes.

Chapter IV: Plots *

This chapter sheds light on various different aspects like choosing the right
property, the pros and cons of the property, the slope of the property, removal
of inauspicious items from the soil, the neighboring environment, classification
of property shapes, extensions or cuts in the directions and corners, the trees on
or close to the property and consideration of road vedha.

Chapter V: Residential Vaastu *

This chapter looks at the different rooms that are constructed in Residential
vaastu as explained in the classical texts as well as in the contemporary con-
text. The use of wood, trees, plants, door placements, energy areas, location of
Windows, Balconies,Wells, Borings, UndergroundTanks, Drainage, and height
of a house have also been considered.

Chapter VI: Summary of Vaastu Rules *

This chapter contains a summary of the 50 golden principles of Vaastu for new
construction, renovation or vaastu correction.

Chapter VII: Jyotish and Vaastu *

This chapter establishes the relationship between Jyotish and Vaastu and ex-
plains the role of Jyotish in arriving at proper and auspicious muhurtas for
Vaastu related activities like laying the foundation stone, starting construction,
door installation, kalash chakra shuddhi, house warming etc.
It also elaborates the procedure for conducting the House Warming Puja.

Chapter VIII: Vaastu Remedies *

This chapter discusses some commonVaastu problems and the possible Vaastu
doshas and remedies related to them.

*NotAvailable inCommercial Edition
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The Options Menu
When you select thismenu, youwill see the following submenu items. All these
items are combined in one single tabbed dialog for convenience and easy access.
The Options dialog box is resizable and you can customize the size by placing
the cursor to the corner of the box and dragging it to the required size. It can be
dragged and located anywhere on the screen. The program will save the size
and location last selected and you will find it exactly like that when you open
the program the next time.

Calculation Options

Vaastu Grid Area
Vaastu specialists adopt different approaches when they draw the Vaastu grid
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cells on the property shape. We can choose from any one of three methods to
determine the placement of the Vaastu grid. Please
note that for perfect square and perfect rectangular
property shapes, the flowing three optionswill give
the same result. This option is usefulwhen the prop-
erty shape is not a perfect square or a perfect rect-
angle.

Largest Circumscribed rectangle:
This is the preferred option of vaastu specialistswho
believe that if a property is not a perfect rectangle, then a hypothetical rect-
angle inclusive of the property area should be considered for placement of vaastu
grid. Although the name assigned to this method contains the word rectangle,
this method can be used for all property shapes including those that have ex-
tensions or cuts of any ratio or proportion.

To understand this better, we should take a bird�s eye view of the property.

A largest possible rectangle is circumscribed over the property shape. This rect-
angle covers the entire property area and in addition, the area which would
have been a part of the property had the property been a perfect square or a
perfect rectangle in shape. The Vaastu grid is drawn on this circumcribed rect-
angle.

The Vaastu padas, which lie beyond the periphery of the actual property shape
are considered to be missing. In this method we take into consideration only
those padas, which fall within the boundary of the actual property shape.
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The advantage of this method is that padas are
awarded a proportionate space in the grid. The dis-
advantage of this method is that depending on the
property shape, many padas may get excluded.

Largest Inscribed rectangle:
This is the preferred option of vaastu specialists who believe that if a property
is not a perfect rectangle, then a hypothetical rectangle drawnwithin the prop-
erty area should be considered for placement of vaastu grid. .Although the name
assigned to this method contains the word rectangle, this method can be used
for all property shapes including those that have extensions or cuts of any ratio
or proportion.

To understand this better, we should take a bird�s eye view of the property.
A largest possible rectangle is inscribed within the property boundary. The
Vaastu grid is drawn on this rectangle. TheVaastu padas, which lie on the outer
periphery of the rectangle can be left as it is or stretched to include the area of
extension on their respective sides as preferred. In this method we take into
consideration all the padas.

The disadvantage of this method is that depending on the property shape, the
rectangular grid area may at times be very small . If the outer padas which lie
adjacent to the extended property area not covered by the largest possible rect-
angle drawn by us at the first level, are optionally extended, then the periph-
eral padas may be disproportionately bigger as compared to the other padas.
The advantage is that no pada gets excluded.
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Actual Plot Shape:
Thismethod can be adopted for properties that have four sides only. The area
under consideration is the actual plot shape area. No extensions or cuts are
considered in this method. Unlike largest circumscribed rectangle, we do not
include any additional areawhile drawing the Vaastu grid. No pada is excluded
or extended in this method. Consequently all the four directions and the four
cardinal directions find their proper place on the property super imposition. In
this method, any direction tilt variation is not reflected by a tilt of the grid. If
the direction tilt exceeds 45 degrees, in that case, the direction Tilt indicator
points to another side of the property.

There is one disadvantage in the Actual Plot Shape method. When the prop-
erty shape is not very close to a square or rectangle, some of the padas get
squeezed up due to space limitations, while others get stretched out.

Here are a few examples of Actual Plot Area for Rhombus, Goumukhi and
square shaped property.
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Direction/Tilt consideration

Let us now elaborate on the three types of tilt considerations. Vedic Vaastu
allows you to choose from any one of threemethods to determine the direction
tilt of the Vaastu grid. Please note that for properties having all the sides per-
fectly aligned to their respective directions, the following three optionswill give
the same result. Formore details readChapter 2: Using Basic Functions of Vedic
Vaastu > Configuring Vedic Vaastu

Best Fit
The Best Fit method has been derived from the ancient classic Vaastu Vidya.
According to this, the best fit tilt directionmethod, which is generally used for
Ekasheetipada Trikona Vaastu or Ekasheetipada Vrita Vaastu can be applied
with equal ease to Ekasheetipada Rectangular Vaastu.

The deity pada allocation generally used in the ekasheetipada system (consid-
ering zero degree north) has been kept intact, and the available area for all the
directions has been allocated equally. Consequently all the four directions and
the four cardinal directions find their proper place on the property super impo-
sition. The grid is drawn concentricallywith 32 padas in the outermost periph-
ery, 24 in the second, 16 in the third, 8 in the fourth and 1 pada in the core. No
pada has been excluded. The padas in the concentric rectangles are also intact,
in as much as that the respective deities have been placed in their individual
positions.

This is one of the most scientific approaches to draw a Vaastu grid (when the
north angle is deviated from its natural position), because of the following:

a. All the directions have been given equal weightage. This is in tandem
with the universe where all the directions occupy an equal span.

b. All the ekasheetipada deities have been assigned their due position based
on the direction.

c. All the eighty one padas have been retained (when there is no cut or
extension in the property) and consequently, there is no loss of padas.

d. This method has been inspired from the ancient Vedic Vaastu classics.
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Image of Best Fit Consideration (Square shape Prop-
erty and North direction tilted by 20 degrees)

It may be noted that the results will vary if we consider a property with an
extension or cut, depending on whether we have chosen the circumscribed,
inscribed or actual plot area options for vaastu grid drawing. So, we need to
relate this to the various options for the Vaastu Grid area individually.
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Compress Fit
This is one of the simpler approaches to draw a Vaastu grid (when the north
angle is deviated from its natural position). Here, all the ekasheetipada deities
have been assigned their due position based on the direction. All the eighty one
padas have been retained (when there is no cut or extension in the property)
and consequently, there is no loss of padas.

A largest inscribed rectangle is drawn within the assigned property area, con-
sidering the north angle deviation. The Vaastu grid is drawn length wise and
breadthwise tomake up the 9x9= 81 cell grid. The Vaastu padas, which lie on
the outer periphery of the rectangle can optionally be stretched to include the
area on their respective sides. In this method, the span of the directions is un-
equal depending on the north angle deviation degree.

Image of Compress Fit Consideration (Property with
cut in NE direction and North direction tilted by 20

degrees)
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Zero Tilt
The Zero Tilt methodworks on the assumption that the north direction is not
deviated from the central position of its respective side. So, the tilt consider-
ation is limited to a 90 degree span.

This implies that if the tilt angle is within the range of +45 degrees and �45
degrees of the 0 degreeNorth compass needle, it will be treated as though there
is no deviation in the north angle. If the tilt angle is within the range of 45 to
135 degree, then the north is uniformly considered to be deviated by 90 de-
grees. Similarly, if the tilt angle is within the range of 135 to 225 degree, then
the north is uniformly considered to be deviated by 180 degrees. Lastly, if the
tilt angle is within the range of 225 to 315 (-45) degree, then the north is uni-
formly considered to be deviated by 270 degrees.

The padas of the grid are drawn with 9 cells length wise and 9 cells breadth

Image of Zero Tilt Consideration (Square shape
Property with North direction tilted by 20 degrees)
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wise to make up the 81 cell grid. Here we need to relate this to the various
options for the Vaastu Grid area.

Measurement Unit
The program allows you to enter the length of the side in any one of the follow-
ing measurement units: inches, feet, meter and yard.

Extend Outer Padas
The program allows you to extend or not extend the outer padas upto the
property boundry line in cases where the Largest Inscribed Rectangle is the
method selected to draw the Vaastu grid.

Ignore Tilt upto
The program allows you to ignore north angle tilt upto the degree specified by
you, as per your preference and practice.

Display Options

These are all the options related to theway the various features or elements are
displayed.

Entity Border Thickness:You can choose either to have a thin or a thick border for
the Entity periphery.

Indicate Auspiciousness in corner: You can decide whether you wish to have this
indication show up in all or any of the corners enumerated here.
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Entity Border Color: The border color can be set as per your preference.

Entity Name, Entity Size, Assistant, Start up Vaastu Tip, Ekasheeti padaGrid#with
or without numbers, Direction Indicator#, Auspiciousness Indicator: You can decide
whether to show or hide these.

Explorer Options

Entities/Objects#:These can be displayed either according to the active category
or the entire range of available entities and objects

Explorer Icon size:The program allows you to select fromSmall, Large, and Large
with name.

Print Options

This menu allows you to set the Printing related preferences.

Margin:TheTop, Bottom, Left andRightmargins in the Print Layout can be set
here.

Page Size: You can select from A3, A4 and Letter size.

# Not Available in Personal Edition
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Color Options

Here you can specify various color options.
You can select unique colors to denote Favorable,Moderate, Neutral andAvoid-
able auspicious directions for object and entity placements.

Report Options
Here you can specify various report related options.

Report Border##
You can decide whether to have a border for every page of the report or not. A
vast range of beautiful borders are available for your selection.

Vaastu Specialist Details
You can decide whether to show or hide the Vaastu Specialist Details at the
bottom of each page of the report.

Opening Page Image
You can decide whether to show or hide the image on the opening page of the
report. This will be specially useful for users who use printed stationery for
their reports and have some pre printed image in place.

## Partially Available in Personal Edition
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Group Similar Entities and Objects
You can decide whether similar objects in the same entity can be grouped
together in the Report. In the sameway, you can choose to group similar enti-
ties in the Report.

Font Options
You can select the font for the various screens by setting the System Font.
English Font, and Point size.
System Font

All the text in various screens uses this system font. You can also specify the
point size for this font.

English Font
This selection allows you to select from a range of English fonts to display the
English text.

Reset to Default Options
You can revert to the default options of the program by clicking on this Reset to
Default Options.

The Print Menu

This menu lets you print a set of pages at once.
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SelectModel

Vedic Vaastu allows the user to select from a pre-organized set of printouts##,
called �Models�, or to make customised set of printouts.

Editing orMaking a NewModel#
The SelectModel screen under the Print menu can also be used to edit or add a
new printout to the existing set of printouts. Open the SelectModel screen by
clicking SelectModel in the Printmenu.

To edit an existing model, select the model you wish to edit and press Edit
button. If you wish to change the name of the model and price, you can do so
in the box Change name or price.

To add a newmodel, select the entry Newmodel and press Edit button. A new
screen will come up. Assign a name to the model in the box Change name and
in case you want to sell the report, give a selling price of the model in the Price
box.

The screen displays all the available printouts on the right side and the print-
outs selected for the model on the left side. If you notice, each printout has
been given a unique number.

## Partially Available in Personal Edition # Not Available in Personal Edition
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To add a printout to the model, click on the printout number listed under the
Available printouts and click on the right facing arrow.

To remove a printout, click on the printout number in the selected printouts list
and click on the left facing arrow. You can also select multiple printouts and
remove them simultaneously.

To insert a printout in between already selected printouts, select the printout
under selected printouts after which you wish to add a new printout. Now
select the printout number in the list of available printouts and click on the
right facing arrow to insert the printout in the model

Click Save to save the model. Click Cancel to close the dialog without saving
the changes that you have made.
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The Tools Menu

Thismenu contains some useful tools to help you
search for or export layouts; access statistics on
groups of layouts; calculate the Aayadi score for
the layout, get information about suitable prop-
erty facing directions and send Emails directly
through this menu. You can also view and print a
complete record of all reports printedwithin a speci-
fied period through the Accounting feature .

Search for Layout $
The Search for Layout is a handy tool to search among the saved layouts.

ChangeDirectory: This button allows you to browse through other directories
in case you have .vas files stored elsewhere and you need to access them.

Search Criteria: There are four possible criteria for searching - Vaastu Category,
VaastuCategory+Shapes, VaastuCategory+Shapes+Sub Shapes andNorth
Angle.

The corresponding fields will appear depending on the search criteria selected
by you. Select the appropriate alternative from the drop down list for each
field. Then click on the �Search� button. The Search results of Matching Lay-
outs will be displayed on the left hand side list box. Selecting any layout from
this list will display its information in the adjacent box.

$ Not Available in Personal and Commercial Edition
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Layout Statistics $

This feature is very handy as it al-
lowsyou to view statistics based on
the Search criteria.

Change Directory: This button al-
lows you to browse through other
directories in case youhave .vas files
stored elsewhere and you need to
access them.

SearchCriteria: There are four pos-
sible criteria for searching - Vaastu
Category, VaastuCategory+ Shapes, VaastuCategory+ Shapes+ Sub Shapes
and North Angle.

The corresponding fields will appear depending on the search criteria selected
by you. Select the appropriate alternative from the drop down list for each
field. Then click on the �Search� button. The statistical results will be displayed
in the Result area in the form of a Table or Graph depending on which radio
button you have checked in the dialog.

Export Layout Data $

This feature allows you to export all the
layout data and save it in a html file at a
location specified by you.

Aayadi Calculator $
The Ayadi calculator is a very handy tool
for determining the auspiciousness quotient
of themother wall of the house under con-
struction. Where necessary, appropriate
modifications can be made and evaluated
to get the desired auspiciousmeasurements.
The calculator automatically converts the
measurement to hasta and angul units for
calculation purposes.

$ Not Available in Personal and Commercial Edition
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Facing Directions $

The Facing Direction window indicates the
favorable property facing direction based on
the birth nakshatra of an individual along
with a general recommendation.

Email $
Email feature in the Toolsmenu opens awin-
dow from where you can send an email di-
rectly. The attach button allows you to at-
tach files by browsing the system.When you
click on Email for the first time, the SMTP
Settings dialogwill open up. The followings
fields will have to be filled up.

From: Enter your Sender Name
SMTP Server: Enter your IP or SMTP Server name.
Port: Enter your SMTP server Port number. The default port is 25.
User Name and Password Check Box: If your SMTP server requires authentica-
tion, then please check this box and enter the User Name and Password in the
respective fields.

Accounting#
This option allows a user to view and print a complete record of all reports
printed within a specified period. The report can be shown, Vaastu Specialist
wise,Model wise or Languagewise.

$ Not Available in Personal and Commercial Edition
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The Window Menu

This menu allows you to tile or cascade all the layouts open at a time. You can
also switch to any of the open layouts through this menu. (Lets refer files as
layouts wherever applicable).

Tile
To display all the open layouts in a tile form.

Cascade
To display all the open layouts in cascade form.

Next
This allows you to navigate between layouts and move to the next opened
layout.

Previous
This allows you to navigate between layouts andmove to the previous opened
layout.

Listed Layouts
Click on any of the listed layouts to switch to that layout. All open layoutswill
be listed here.

$ Not Available in Personal and Commercial Edition
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The Help Menu

Manual
Click on Manual to read help on any topic.

Vaastu Tutorial*

This section contains some Vedic Vaastu lessons in the form of an extensive
tutorial. The lessons have been organized systematically and are presented in a
lucid language. This is almost a complete tutorial with a rich introduction and
a lot of Sanskrit shlokas and quotations that make interesting reading.
The Tutorial comprises of the following chapters.

Table of Contents
Chapter I: Introduction and Significance of Vaastu Shastra
Chapter II: Vaastu Shastra: Objectives and Basic Principles
Chapter III: Types of Vaastu
Chapter IV: Plots
Chapter V: Residential Vaastu
Chapter VI: Summary of Vaastu Rules
Chapter VII: Jyotish and Vaastu
Chapter VIII: Vaastu Remedies

*NotAvailable inCommercial Edition
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Vaastu Muhurtas
Gives you access to a service for online calculation of Vaastu related muhurtas
like Laying Foundation stone, Door Installation, Housewarming etc.
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Show Vaastu Tip at Startup
The program supports a wide
range of Vaastu tips which are
randomly displayed when the
program starts.

About VedicVaastu
Shows information about the
software and its developers.
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Feature Name

Residential: Bungalow
Residential:Multi Storey Plot
Residential: Flat
Commercial: Office
Commercial: Shop/Showroom
Commercial:Hotel/Resort/Club
Commercial:Hospital/NursingHome
Commercial:EducationalInstitute
Industrial: Cottage Industry
Industrial:SmallScale Industry
Industrial:LargeScale Industry
Religious: Temple
Religious: Ashrama/Matha
Supported Shapes
Supported Sub-shapes
PlotMode (Macro Vaastu
EntityMode (Micro Vaastu)
Auspiciousness Indicator
VaastuAssistant
Startup Tips
FileManager
Floor Manager
Vaastu Specialist
Full Screen Mode
EkasheetiPadaGridDisplayoptions
Direction Indicator
Report Borders
Printing to PDF
Vaastu Tutorial
Model Creation & Editing
CalculationOptions
DisplayOptions
Explorer Options
Print Options
Color Options
Report Options
FontOptions
Accounting
Vaastu Tools
Inbuilt Emailing Feature

Personal Commercial Professional

Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
No No Yes
No No Yes
No No Yes
Yes Yes Yes
Yes Yes Yes
No No Yes
No No Yes
No No Yes
8 8 8
40 40 40
Yes Yes Yes
No Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
No Yes Yes
Yes Yes Yes
Yes Yes Yes
No Yes Yes

  Always On        Can be Controlled   Can be Controlled
  Always On       Can be Controlled   Can be Controlled
              2                   17                 17

Yes Yes Yes
Yes No Yes
No Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
Yes Yes Yes
No Yes Yes
No No Yes
No No Yes

Feature Availability in Different Editions of Vedic Vaastu
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Personal to Commercial Edition
All Features of Personal Edition
Plus Micro Level support
Plus File Manager
Plus Full Screen Mode
Plus Control over Ekasheeti Pada Grid Display Options
Plus Control over Direction Indicator
Plus Additional Reports
Plus 15 Report Borders
Plus Model Creation & Editing
Plus Accounting module
Less Vaastu Tutorial

Commercial To Professional Edition
All Features of Commercial Edition
Plus 6 Extra Vaastu Categories with Microlevel Support
Plus Vaastu Tutorial
Plus Advanced Vaastu Tools
Plus Inbuilt Emailing Feature

Personal To Professional Edition
All Features of Personal Edition
Plus 6 Extra Vaastu Categories with Microlevel Support
Plus Micro Level support
Plus File Manager
Plus Full Screen Mode
Plus Control over Ekasheeti Pada Grid Display Options
Plus Control over Direction Indicator
Plus Additional Reports
Plus 15 Report Borders
Plus Model Creation & Editing
Plus Accounting module
Plus Vaastu Tutorial
Plus Vaastu Tools
Plus Inbuilt Emailing Feature

Upgrade Features in Different Editions of Vedic Vaastu
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Index

A

About VedicVaastu  105
Accounting  96, 101
Actual Plot Area  17
Auspiciousness Indicator Window  45
Ayadi Calculator  100

B

Bring to Front and Send to Back Commands  54

C

Calculation Options  85
Cascade  102
Close  73
Color Options  95
compass  18
Configuring Vedic Vaastu  13

Selecting the Direction/Grid consideration  18
Selecting the Vaastu grid Area  13
Setting the color preference for auspicious-

ness le  30
Copy Layout  75

D

Define Plot Dimensions  35, 67
Delete Command  53
Designing a Plot layout  37
Designing an Entity layout  39
Display Options  93

E

Edit Menu  74
Editing a Layout  42
Ekasheeti pada grid  81
Entity Explorer  49
Entity Mode  76

Entity name  81
Exit  74
Explorer Tool Box  49
Export Layout Data  100

F

File Menu  64
Floor Manager  71
Font Options  96
Full Screen  76

H

Help Menu  103
How to apply the plot direction tilt consideration

19
How to ascertain the direction  tilt of your plot  18

I

Installation procedure  5

L

Language  74
Largest Circumscribed rectangle  14
Largest Inscribed rectangle  15
Layout Data  74
Listed Layouts  102

M

Manual  103
Menu References  62
Models  58
Move Command  47, 51, 52, 53, 75

N

New  64
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O

Object Explorer  51
Open  64
Opening an Existing Layout  30
Options  Command  52, 53
Options Command  54
Options Menu  85

P

Placing an object over another object  41
Placing Entities  37
Placing Objects  39
Plot Mode  76
Print  73
Print Menu  96, 99
Print Options  94
Printing a Layout  42
Printing a Set of Pages (Model Printing)  56
Printing from the Report menu  42
Printing Layout Pages  55
Printing Report Menu Printouts  55
Printouts from the Screen  42

R

Report Menu  81
Report Options  95
Resize Command  52, 53
Resizing Entities  38
Resizing Objects  40
Right Click on Entity  51
Right Click on Objects  52
Right Click on Vaastu Assistant  54
Right Click Options  51
Rotate Command  53
Rotating Objects  40

S

Save  73
Save As  73
Saving a Layout  41
Saving multiple floor layouts for plot layout  43
Select Model  97

Select Plot Shape  34
Select Vaastu Category  32
Shortcuts  54
Specify Direction  36, 69
Status Bar  48, 79
Switching between Plot and Entity Layouts  43
System Requirements  5

T

The Reports Menu  81
Tile  102
Tool Bar  78
Tools  Menu  99
Tutorial Menu  82

V

Vaastu Specialist  75
View Menu  76

W

Window Menu  102


	
	Chapter 1 : Installation 
	Windows : System Requirements 
	Installation procedure 
	Chapter 2 : Using basic functions of Vedic Vaastu 
	Configuring Vedic Vaastu 
	Selecting the Vaastu grid Area 
	Selecting the Direction/Grid consideration 
	Setting the color preference for auspiciousness levels 
	Opening an Existing Layout 
	Creating a New Layout 
	Select Vaastu Category 
	Select Property Shape  
	Define Property Dimensions 
	Specify Direction 
	Designing a Property layout  
	Placing Entities 
	Removing Entities 
	Resizing Entities 
	Saving a Layout 
	Editing a Layout 
	Printing a Layout 
	Chapter 3 : Using other functions of Vedic Vaastu 
	Switching between Plot and Entity Layouts 
	Saving multiple floor layouts for plot layout 
	Auspiciousness  Indicator Window 
	Tool Bar 
	Status Bar 
	Entity Explorer 
	Context Menu: Right Click Options 
	Right Click on Entity 
	Right Click on Objects 
	Right Click on Vaastu Assistant 
	Shortcuts 
	Chapter 4 : Printing through Vedic Vaastu 
	Printing Layout Pages 
	Printing Reports Menu Printouts 
	Printing a Set of Pages (Model Printing) 
	List of Models 
	Chapter 5 : Menu References 
	The File Menu 
	The Edit Menu 
	The View Menu 
	The Options Menu 
	The Print Menu 
	The Tools  Menu 
	The Window Menu  
	The Help Menu 
	Feature Availability in Different Editions of Vedic Vaastu 
	Upgrade Features in Different Editions of Vedic Vaastu 
	Index 


